
The contents of this document may not be copied nor duplicated in any form, in whole or in part, without 
prior written consent from Lumos. Lumos makes no warranties as to the accuracy of the information 
contained in this document or its suitability for any purpose. The information in this document is subject to 
change without notice. 
 
Copyright ©  2010 Lumos. All rights reserved 

User Manual 



  

 
 

X-Loupe Solution User Manual www.x-loupe.com  Page 2 

 

Preface 

Thanks on behalf of the Lumos team for using Image Management Software -X-Loupe Solution. 

Lumos wants to carry out its service and, with this preface, provide an introduction to the user 
manual, so that everyone can gain the fullest possible advantage of it. 

The graphical user interface (GUI), is modernized to the new de facto ‘Office 2010’ GUI. It has a 
very logical grouping of functionality – in most cases you will find the functionality where you 
expect to find it. The dock bars can be rearranged or hidden after individual needs. 

The software package is multilingual, it includes the following languages: English, Japanese, 
Traditional Chinese, and Korean. The language can be switched on-the-fly – no need to install 
special packages to have your language. 
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1. Start Installations 

If you have problems installing or using the software, you can e-mail our technical support 
group at x-loupe@lumos.com.tw or you can contact your local dealer or distributor to get 
further direct support. 

Please also visit our homepage at www.x-loupe.com for software updates or other 
improvements for your X-Loupe. 

Sequence to install X-Loupe Solution 

A. Detach any X-Loupe dongle from your PC 

B. Install the new software package from your CD or from www.x-loupe.com. 

C. Attach dongle (Note: X-Loupe Solution requires a dongle to run). If it is the first time the 
dongle is attached you should see a 'Found new Hardware' sequence. Wait for the 
sequence to complete. Later dongle attachments will issue the Windows 'ding-dong' 
sound 

D. Start X-Loupe Solution software. 

Dongle Check 
 

To check that the dongle is properly 
installed, see the device manager, 
where the USB Dongle icon should 
appear. 

 

 

mailto:x-loupe@lumos.com.tw
http://www.x-loupe.com/
http://www.x-loupe.com/
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2. X-Loupe Solution - Image Management Software 

X-Loupe Solution is an image handling software allowing advanced functions for zooming, 
annotation, measurements, and locating and maintaining images. The software can create 
online image galleries with image browsing capabilities. 

The main features of the software are Thumbnails, Multiple views, Annotation, Measurement, 
Active Zoom, Extended Exposure, Extended Focus, and Reporting (Excel and PDF).  

2.1 Initial View 

After the program has been installed, your screen should look like this: 

 

X-Loupe Solution has a modern and intuitive user interface based from Microsoft Office 2007. 
Functionalities are grouped logically and the program is easy to use.  

Features are: 

 Device panel for selection of camera and optics 

 Panorama view for easy image maneuvering in zoomed images 

 Multiple image galleries with thumb view 

 Easy storage of images 

At the top of the window, you will see the Quick Access Toolbar. The Quick Access 
Toolbar in the live preview: 
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2.2 System Settings 

The upper-left button in the GUI opens a ‘standard’ office drop-down menu, allowing: 

• File open 
• File save 
• Print 
• Send 

The System Maintenance button opens functions used seldom, e.g.: 

• Edit Optics Configuration 
• Language and Color 
• Open Application Data Folder 
• About 

2.3 Language Selection 

Language can easily be switched. 

Select System Maintenance in the X-Loupe 

logo menu. It is allowed to select Language 

and Color to set the language as another 

language: 

2.4 Dock Bars 

The program uses the concept of document docking. It allows the dock bars to be hidden or 
shown in fixed locations 

To hide the dock bar click the ‘pin’: 
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To view, move the cursor to the tab: 

 

To show the dock bar click the ‘pin’ again: 

 

It is also possible to move and rearrange the dock bars to other locations in the GUI.  

Move a dock bar on top of another dock bar by dragging the dock bar, and place it on the top 
spot of the cross. : 

   

 

Dock to left: 

 

Dock to bottom: 

 

Dock to right: 

 

Docking may seem complicated and confusing – it is however a nice feature. If it ends up in a 

mess you can always select Reset user interface layout in the System Maintenance menu. 
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Saving a layout is also done from the System Maintenance menu. 

2.5 Image Galleries 

X-Loupe Solution has two Image Galleries. Images can 
be dragged and dropped in between the galleries. Click 
Change Directory to browse the thumbnail images of 
specified directory. The images will be displayed 
ordered by file name. Thumbnail size can be Small, 
Medium, or Large. 

Select one thumbnail image and click Open button to 
view the whole image. 

 

2.6 The Progress Bar 

For lengthy operations, the progress bar shows the progress of the current operation. 

2.7 Free Memory Indicator 

Some operations require a lot of free (and unfragmented) memory. 

Usually the memory indicator is not visible – which indicates that there is 

plenty of free memory. A green indicator shows the remaining free 
memory. Yellow or red indicators also show free memory, but indicate 
that X-Loupe Solution is running short of memory. 
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2.8 Panorama View 

The Panorama View dock bar can display a view of 
the main image at a smaller magnification and a 
rectangle indicating the size and position of the 
visible portion of the image. The blue rectangle can 
be dragged around in Panorama View with the left 
mouse button to pan or move the image. 
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3. System Settings 

It is important to calibrate your cameras and optics before using them for measurements. 
Using the program without correct calibrations will result in incorrect calculations and 
measurements 

3.1 Edit Optics Configuration 

Select System Maintenance in the 
X-Loupe logo menu. Then select Edit 
Optics Configuration: 

 

Right-click on Optics Configuration to 
name this system, then select Add: 

 

Right-click on the new system name to 
name the objective lens in use, then 
select Add: 
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Click Save Configuration button, then 
close the dialog box.  

 

3.2 Calibrate an objective lens 

Images acquired with a wrong calibration setting can be recalibrated. The calibration data 
can apply to other images taken by the same objective lens. 

To calibrate an objective lens: 

Firstly, take a photo with a reference ruler 
and open the photo with the software. 
Select the correct Optics device and 
Magnification from Device Select dock 
bars. Click Calibrate and select Draw 
calibration ruler for calibration to draw 

ruler on a known reference. 

 

 

Or use Ruler from Measurement tools to 
draw a ruler on a known reference. The 
measurement may show an incorrect 
value. 
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Click on Calibrate, then insert the true 
length of the ruler in empty space and 
choose the right unit: 

 

Then select Calibrate this optics objective 
lens to finish this calibration process: 

 

 

★  We recommend to calibrate every device manually. 

★  For other images, select the same device (Optics device) and objective lens (Magnification) 
to apply the calibration data.  

★  Lumos provides factory-setting calibration data for each X-Loupe series and models. Please 
visit our webpage www.x-loupe.com to download the calibration files and import the 
calibration data using Import Device function.  

http://www.x-loupe.com/
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3.3 Backup/ Restore Configuration, Import/Export Device 

To backup the calibration data of whole 
configuration, please select Backup 
Configuration and input backup filename 
on the pop-up dialog box.  

 

To restore the calibration data of whole 
configuration, please select Restore 
Configuration and input previous backup 
filename on the pop-up dialog box.  

★ Please note that all calibration and 
configuration data will be overwritten 
after the restoring process.  

 

For one specific device, select Export 
Device to export calibration data of all its 
objective lenses. Input the filename in the 
pop-up dialog box to save the export file.  

 

To import the whole calibration data of one 
specific device, please select Import Device 
and input previous export filename in the 
pop-up dialog box. 

There will be a serial number attached if 
the device name is duplicated. 
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3.4 Import Factory Calibration Data 

Lumos provides factory-setting calibration 
data for all X-Loupe series and models. 
Please visit our webpage www.x-loupe.com 
to download the calibration files and 
import the calibration data using Import 
Device function.

 

http://www.x-loupe.com/


  

 
 

X-Loupe Solution User Manual www.x-loupe.com  Page 15 

4. The Home Tab 

The Home tab contains the selection of font tools and tabs arrangement tools. 

 

 

 

4.1 The Editing Tools 

The editing tools can be used to highlight a selected area. The selected area can be copied and 

pasted. A selected area can also be used for cropping 

     

4.2 The Formatting Tools 

These tools set the color, font line widths, and more for the annotations and measurements. 

4.3 Reporting 

A distributable report – a report that can be read without using the X-Loupe Solution 
software– can be generated. 

An annotated image can be made into a report in several ways: 

• Realize: The annotation can be ‘burned’ into the bitmap. 

• Excel report: The image is inserted into an Excel spreadsheet, measurements are also 

Editing tools 

 

Formatting tools 

 

Reporting Tools Fane arrangement 

tools 
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inserted. 

• PDF report: The Excel report can be converted to a PDF document. 

★ There is no need for installing Microsoft Excel or a PDF printer; all conversions are done 
within the X-Loupe Solution software. 

4.3.1 Realize 

Realize makes the annotation a part of the image. This is good e.g. when sending an image to 

a person without access to X-Loupe Solution Software. This allows viewing of annotated 

images in most commercial image viewers. 

Select Realize to write the annotation and 
measurement into the image itself. It is not 
possible to modify those annotation and 
measurement after realizing.  

 

4.3.2 Excel Report 

When the measurements and annotation are done, it is possible to export the data to an Excel 
document. This allows for further processing in the spreadsheet. 

The reporting uses an Excel template, defining the layout of the report. Image, measurement 
results and other information is placed in the spreadsheet by identifying tags. A template 
must be defined, click the Template button in order to navigate to a template.  

The report template is located in the application data 
folder (C:\Documents and Settings\%USERNAME% 
\Application Data\Lumos Technology). It is possible to 
make some modifications on the template report, like 
changing the logo, header etc. DO NOT change the 
word with %, e.g. %DATE%. 

Valid tags are: 

• %IMGS% defines the upper-left corner of image 

• %IMGE% defines the lower-right corner of image 

• %MEAS% defines column for measurement results. 
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• %UNIT% defines column for measurement units. 

• %DATE% defines date. 

• %TIME% defines time. 

• %CAMERAMODEL% defines camera model. 

• %PICTUREDPI% defines the image DPI. 

After a template has been defined, simply click the 
Excel report button. The document will be 
automatically opened after generation if the Open 
report option is checked. 

 

 

 

The illustration to the right is the 
final report with logo, header, date 
and time, data and image. It is 
possible to make some 
modifications on the report, like 
adding comments, changing the 
logo, etc.  
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4.3.3 PDF Report 

To make distribution very easy and flexible, a report can be published as PDF.  

The PDF report generates a report, using the Excel 
template, and converts it to PDF. 

One temporary Excel report will be generated based 
on the report template. The PDF report is generated 
by converting that Excel report to PDF format.  

It is also possible to convert an existing Excel report to 

a PDF report by selecting Excel to PDF. 

 

The illustration to the right is the 

final PDF report with logo, header, 

date and time, data and image. 

 

4.4 The Window tools 

The Close button can be used to close all still images. The dropdown allows closing images 

only of a specific type, e.g. Extended Focus images. 
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5. The View Tab 

This tab holds functions for image viewing, e.g. fit, stretch, zoom etc. TDI / MDI switches 

between two types of arrangements for image viewing. 

 

 

 

 

 

 

 

 

 

Zooming tools are available only 

while viewing Live Preview in 

Normal Mode. 

Zooming tools are only available while 
viewing in Normal Mode. 
 

Pan function makes it easier to move a 
magnified Image. 

Magnify Glass follows the mouse movement. 
The lens can be moved around the screen to 
view 
magnification of any screen area.. 
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6. The Measurement and Annotation Tab 

 

 

 
 

 

6.1 Annotation 

Annotations are notations added to the 
captured image. Choose a type of 
annotation in the Measuring menu, then 
draw on the image:  

Use the formatting tools from Home to 
change font/line size and color. 

 

6.2 Measurement 

X-Loupe Solution has many measuring functions: ruler, ellipse, protractor, three point circle, 
circle center distance, point to line distance etc. 

To measure a(n); angle, distance, area… Choose 
the tool, then draw on the image:    

The calculated results will automatically show 
next to the drawing. Use the formatting tools 
from Home to make font/line adjustments as 
desired.

Annotation tools 

 

Measurement tools 

 

Use the Formatting tools from Home to change the Font/line 
color or size of the annotations or measurements. 
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6.3 Save the Annotations and Measurements 

Here are two ways of saving the annotations and measurements: 

6.3.1 Save the Annotations and Measurements in Separate Files 

This is done in the same way as saving an image.  

The annotations and measurements belonging to the image will appear automatically by using 
X-Loupe Solution to open this image, and editing is possible. Other image viewer will only 
show the original image without the annotations and measurements.  

One of the ways to save the file is to click on the disk button located in the galleries. Hereby, 

the image and the measurements and annotations will be saved in separate files. 

 

 

6.3.2 Save the Annotations and Measurements in the Same Files 

Another way is to save the image and the annotations and measurements in one file:  

 

 

 

 

The program will burn the annotations and measurements on the original image, so a new 
image is created. In this way the annotations and measurements will no longer be editable. 
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7. The Still Image Tab 

In the Still Image menu there are several adjustment tools available for changing the 
specifications of an image. There are functions for noise removal, intensity remapping and 
much more. 

 

 

 

 

 

 

Use the effect or color tools 

to adjust the image as desired 

See the image 

specifications 
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8. The Image Extender Tab 

Image Extender is only available in X-Loupe Solution Premium. The Extended focus and 
Extended exposure functions can create an image, where multiple depths and multiple 
exposures are all in focus at once, by putting the different layers together to one image. 

 

8.1 Extended Focus 

Microscopy imaging often suffers from limited depth-of-focus. However, the object can be 
“optically sectioned” by moving the object along the optical axis; different areas appear in 
focus in different images. Extended focus function in X-Loupe Solution, can combine those 
images into one single sharp image. If the images have different angles to the optical axis, as is 
the case with stereo microscopes, the software will automatically compensate for this. 

The combination of the extended focus capability in X-Loupe Solution and the extremely high 
resolution capability of the X-Loupe makes it easy to capture stunningly high quality images 
with almost unlimited focus depth, ideal for research and routine work. 

Example: 

Capture several images from top to 
bottom at the different focus levels 
(increase or decrease focus with as 
similar intervals as possible). For 
example, if the object of interest has a 
depth of 1mm and the depth of focus of 
the optics of the microscope is 0.25mm, 
four images must be captured. 

Then select Execute, and wait.   
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Source Images: 

  

Extended focus 
image:  

 

 Please note that only images with the object of interest must be open. Other images of 

different objects must be closed. 

 Please note that the output image will not be ready immediately, as the extended focus 

calculation takes some time. 

8.2 Extended Exposure 

Extended Exposure combines multiple images, each captured with different exposure time 
and having only a part of the image correctly exposed. This is very useful when the object 
under inspection has reflections, very dark or very bright areas in combination, thereby 
making it impossible to expose the total image correctly with one single capture. X-Loupe 
Solution can combine these images into one single well-exposed image. 
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Then select Execute, and wait. 

Taking photo of 
fingerprints on a 
surface with high 
reflection and very dark 
or very bright areas in 
combination.

  

Extended exposure 
image: 

 

 Please note that only images with the object of interest must be open. Other images of 

different objects must be closed. 

 Please note that the output image will not be ready immediately, as the extended 

exposure calculation takes some time. 

 


